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Introducing MathView

What is MathView?

MathView is a program for doing mathematics. More formally, MathView is a 
Computer Algebra System, meaning it can manipulate mathematical equations 
and expressions in a symbolic or algebraic manner. This feature sets MathView 
apart from other programs or, for that matter, most calculators, which require you 
to use numerical values. 

MathView is different from other Computer Algebra Systems because of its unique 
graphical interface and the way it displays both inputs and outputs. When you 
enter equations, MathView displays the inputs in real mathematical notation, as 
opposed to a command-line display. After you manipulate equations and 
MathView generates the answer, the answer also is displayed in real mathematical 
notation.    

MathView allows you to manipulate equations: by using menu selections; by 
clicking on Palette icons; or by invoking command key equivalents. Take, for 
example, the following problem where the goal is to solve for y, and then generate 
a graph.    

You solve by first selecting y, and then clicking on the Isolate icon (on the top 
row of the Palette).   

MathView solves the equation for y.  

Graphing the equation is as easy as selecting it and clicking on the linear graph 
icon on the Palette.  

You can save or print your MathView documents, send them via e-mail to a 
colleague that uses a different platform, or copy parts of them to other documents. 
In addition, you can annotate your workspace with words and pictures as well as 
produce animations.

Real mathematical 

notation...

Command-line 
notation...Int(x^2,x)

x2∫ dx

Do not worry about 
trying this example at 
this time. The remainder 
of the guide will show 
you step by step, how to 
input and solve 
equations as well as 
how to generate graphs. Select y and click on Isolate

Select equation and click on 

MathView 
generates 
the graph 
automatically.
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How to Use this Guide

The objective of this guide is to show you how to use MathView through 
examples. The guide starts out showing how to install the program and then 
presents a comprehensive example (see “Starting Example #1” on page 16). This 
example is for everyone, even for those who do not like to read manuals. It gives 
you a good first look at MathView, and provides a foundation for further 
exploration. This example may be all that you require; if so, you can use the 
remainder of the guide as a reference. For some, the reading and working of the 
examples which remain will be the way to go.

After the first example, the chapter called Preliminaries (page 27) covers the most 
important and basic MathView manipulations and procedures. 

After Preliminaries, the approach changes. Starting with the chapter called 
Functions (page 97), the guide introduces MathView manipulations by including 
them in familiar mathematical subjects. Each section starts with a list of MathView 
skills and commands that the section features along with a short introduction. The 
chapter then presents examples demonstrating those skills. 

After you have mastered the basics of MathView, you will find the table of 
contents, the appendix, and the index valuable guides in directing you. If you have 
a question about the use of a menu or palette item, go to the index and find where 
in the guide an example demonstrates the skill.   

Most of the examples are of an analytical nature, with little real world application. 
For example, you will look at slope as a subject in its own right, without 
discussion of its application in the areas of velocity and acceleration. The guide, 
for the most part, does not teach the mathematics, but how to use MathView to 
solve mathematical problems. 

• A bullet precedes the steps you are to follow in examples. Commentary is 
formatted like the rest of this page. 

MathView is a mathematics engine, in the same way some consider a spreadsheet 
program an accounting engine. Both start out with a blank document where you 
enter problems and use the program tools to solve those problems. MathView can 
help you solve all but the most advanced mathematics. You can use it for 
mathematics curriculums found in high schools and all the way through most 
undergraduate programs; if you are a scientist or an engineer you will find 
MathView an invaluable tool. 

MathView has many powerful tools, unavailable in other programs, that can help 
you understand the math. Your imagination is your only limitation.  

Besides this guide, many MathView resources are available to you. Several books 
on the use of the program are available, and if you can connect to on-line services, 
you will find a network of people and resources available that can enhance the 
usefulness of the program. To find updated information, connect to the Waterloo 
Maple web-site (http://www.mathview.com).

Many have said that, in this computer age, learning and using mathematics will 
never be the same. Once you learn how to use MathView, you will see why. 
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Installing on a Macintosh 

The following preparation instructions apply to all Macintosh System versions. 
Do not follow these instructions if you are using a computer with Microsoft 
Windows. See page 8.

Serial Number Please take note of the serial number on the cover of the CD and on your 
Registration Card. You need this number to install the program and when 
upgrading.

System 
Requirements

• MathView works on a Macintosh Plus (68030 processor), or later model 
Macintosh. (An older Macintosh upgraded to the equivalent of a Plus is 
satisfactory.) 

• The minimum memory requirement for the MathView program alone is  
2.0 Mb RAM, although 3.0 Mb is suggested.

• You must have a hard disk with at least 3 Mb of free space for MathView and 
its related files. 

• MathView is supported on System 7.1.1 or later.

Symbol Font and 
Greek Letters 

In order for you to use Greek letters and other symbols in equations, you must 
have the Symbol font installed in your System. The Symbol font comes with all of 
Apple Computer’s system versions. Follow the Macintosh documentation to learn 
how to install it on your System.

MathView 
Application 
Installer

All you have to do to install MathView onto your computer is to double-click on 
the installer icon (called MathView Installer). The installer will check for the type 
of CPU you are using and install the appropriate version. 

Two  dialogs will open in order below. When you click on the first one, the 
installer will start its process. The second dialog tells you how much disk space 
the program will take up on your disk. Click on the Install button or press 
There is another installer, the MathView Internet Installer. This file is discussed in 

the section; “MathView and the Internet” on page 213. 
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The installer will open the following dialog box, giving you the opportunity to 
choose the location on your disk of the MathView folder.

After you have chosen the location and have clicked on the Install button or 
pressed , the installation will proceed. The following progress box will 
display on your screen as the installer expands the program

The next box that opens is the personalization dialog. Fill in your name and your 
organization in the appropriate boxes, along with your serial number.  Enter the 
rest of your serial number exactly as it appears on your registration card. Click on 
the OK button or press .   

The MathView installer will close down and unlock the program. If you type in the 
wrong serial number or do not use names with at least six letters in them, you will 
be alerted and the program will close down. Open the program back up, by 
double-clicking on the MathView program icon, and enter the information again.

Warning: 
You must have a name 
and organization with at 
least 6 characters.

Program Icon
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Web-Browser 
Plugins

There is an internet browser plug-in called MathView Internet on the MathView 
CD. MathView™ Internet is a web-browser plug-in designed for use with 
browsers such as Netscape™ Navigator, Microsoft Internet Explorer, or 
Cyberdog. To install, follow the instructions in the ReadMe file contained in the 
folder labelled “MathView™ Internet”. See “MathView and the Internet” on 
page 213 for more information.

Notebooks Folder The folder called Notebooks which the installer places in your MathView folder 
contains several special notebooks for your use. They contain examples and are 
configured to special topics.

New Notebook The document called New Notebook is a MathView file which acts as a type of 
stationery pad. Each time you open MathView by double-clicking on the program 
icon, this specially configured file will open as an Untitled document. Also when 
you choose File R New Notebook, this file will open as an Untitled document.

Using the 
Application

To open the MathView application from the Finder, double-click on the MathView 
icon.  

Closing the 
Application

To stop using MathView, choose Quit from the File menu.MathView may ask you 
to save open files.

Increasing 
Application 
Memory Size

To create large notebooks and QuickTime animations, you must increase the 
MathView application memory size. First, close MathView. Now, select the 
application in the Finder and choose Get Info from the File menu to bring up the 
Info dialog.    

This dialog looks 
slightly different under 
different System 
versions.
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The box in the lower right hand corner labelled “Preferred size” specifies the 
amount of memory you want available to the application. Enter the number of 
kilobytes you prefer and close the window.  



8

Introducing MathView

Installing on Windows 

The following preparation instructions apply to computer systems with Microsoft 
Windows. Do not follow these instructions if you are using a Macintosh computer 
(see page 4).

Serial Number Please take note of the serial number on the cover of the CD and on your 
Registration Card. You need this number to install the program and when 
upgrading.

System 
Requirements

• To run MathView, you must have a computer with an 80386 or later CPU 
running Microsoft Windows (version 3.1 or later in enhanced mode), 
Windows 95, or Windows NT.

• You must make at least 2 Mb of RAM and 3 Mb of free hard disk space 
available for MathView and its related files.

Symbol Font and 
Greek Letters 

In order for you to use Greek letters and other symbols in your equations, you 
must install the Symbol font for use with Windows. All Microsoft Windows 
versions have the Symbol font.

Follow your Windows documentation to learn how to install the font on your 
system.

Installing 
MathView on a 
Windows System

These instructions show screen shots of a Windows 95 installation. They also 
assume the hard drive is the c: volume and the CD drive is the d: drive.

Insert the CD into the drive.

With your computer currently running Windows, close any open applications. 
From the Windows Program Manager’s File menu  (Windows 3.1 or 
Windows NT), or the Start menu (Windows 95), choose Run. In the Command 
Line box (Windows 3.1 or Windows NT), or the Open box (Windows 95), type 
d:\install.exe. 

Using the Install 
Program

The Install program starts up and shows the following dialog. 
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The installer will create a new directory named MathView at the path the dialog 
specifies. If you want a different name or a different directory, type a new 
path-name in the box.

Exit Install If you do not wish to install MathView at this time, choose Exit Install to leave 
the install program and return to Windows. If you stop the installation process, no 
files will be installed on your disk.

Continue Install Click Continue to install MathView.

Copying Files When you continue with the installation, the install program decompresses and 
copies various files to the specified directory and informs you of its progress.  

Creating a Group After you copy the files to your hard disk, the Install program asks whether you 
want to create a MathView group or skip it.    

Unless you are re-installing MathView and already have a MathView group, click 
Create.

Exiting the 
Installer

When the installer finishes, it returns to Windows, where the MathView group is 
open for you.

Personalizing 
MathView

Double-click the MathView application icon from the MathView group in 
Windows (or choose the MathView item from the Program section of the Start 
menu in Windows 95) to run MathView.     

The first time you open the program, a dialog appears for personalizing your copy 
of MathView. Enter your name, organization, and serial number in the places 
provided. You can find the serial number on the cover of the CD and on your 
Registration Card. Enter the rest of the serial number exactly as it appears on your 

You may type another 
name for the group.
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Registration Card. When you have completed the information click OK or press 
.   

After you have done this, MathView will close down and unlock the program for 
your use the next time, and all subsequent times you open MathView. If you type 
in the wrong serial number, or do not use names with at least six letters in them, 
you will be alerted and the program will close down. Open the program back up, 
by clicking on the MathView program icon, and enter the information again.

Using the 
Application

Double-click the MathView icon to open the MathView application.  

Closing the 
Application

Choose Exit from the File menu to stop using MathView. MathView may ask you 
to save open files.     

Warning: 
You must a name and 
organization with at 
least 6 characters.
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Writing Conventions

For the most part, the examples in this guide are independent of each other. This 
means that once you have read and understand this introductory chapter and the 
chapter called Preliminaries, you can just select a topic of interest from the 
contents and go directly to it. This guide is your introduction to MathView. It 
discusses the most important concepts and builds a framework of knowledge 
which you can then expand upon depending upon your needs. 

The guide assumes you have a basic knowledge of the mathematics. Numerous 
areas do exist, however, where you will review the underlying mathematical 
concepts to help you make the link between the old methods and the new 
computer methods. You will find MathView useful whether you are a beginning 
student of mathematics, or a scientist or engineer who needs to analyze the most 
complicated equation.

Help The Windows version has a separate on-line help system, that you access from the 
Help menu. You access help with the Macintosh version by using Apple’s Balloon 
Help.

Anomalies This guide uses screen-shots of Macintosh windows and dialogs which may have 
a slightly different appearance than what you will see on your screen, depending 
on the platform and font you are using. The font you see in the screen-shots is 
Adobe’s New Century Schoolbook  (italics on). 

All versions of MathView are virtually the same except for the location and 
appearance of the main menu (at the top of the screen in the Mac and at the top of 
the Notebook window in Windows). Command key equivalents are different too, 
depending on the platform. All manipulations are the same, and notebooks in one 
platform are 100% compatible with other platforms. 

Fonts used in this 
Guide

The body of the guide uses the Times font. The five other fonts in the guide help 
you link what you see in the guide to what you see on your screen.

• Chicago: Denotes menu selections and dialogs. For example, Manipulate R 
Simplify tells the reader to select the menu item Simplify under the 
Manipulate menu. 

• Courier: Instructs the reader what keys to press to input equations to the 
workspace. For example, when you type:  sin(x^2   the result will be the 
following:   

• Helvetica 8pt: Notates screen shots and side-column notes.
• Helvetica 18 and 10pt Bold: Main section and side headings.
• NC Schoolbook:  Variables and some dialog text, in the body of the guide.

Screen Shots The guide displays equations in the New Century Schoolbook  font captured 
from Macintosh notebooks (using a screen-shot utility). Because equations and 
graphs, in some cases, are scaled down to fit in a particular area, they may appear 
smaller than what you see on your screen.

Courier font represents 
input in the beginning. 
After the first section, it 
is mixed with other 
styles. For example, 
when instructed to input 

sin (x2), you will know 
that you type;  
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Many times, screen-shots are of only part of the whole Theory (a Theory is a 
group of related mathematical propositions). Therefore, your workspace may 
show more than what the guide shows. In addition, some of the screen-shots show 
manipulations which only temporarily display on your screen. On occasion, the 
guide shows what you will see during these manipulations.

A picture of the cursor in the screen-shot normally indicates where a selection 
occurs or where a mouse click occurs.

Expressions the guide highlights in gray, in most cases, show the selected portions 
of the equation before you invoke the manipulation.  In most, but not all, cases the 
guide shows hightlighted results, too, because MathView highlights results after 
manipulations occur.

Manipulations You will manipulate equations by using one of four methods: by menu selection; 
by Command key action; by clicking on Palette icons; and by using the “Hand” 
(see section to follow). The Chicago font notates menus, with arrows designating 
sub-menus. Thus, the Auto Simplify Preference item, is noted as Manipulate R 
Manipulation Prefs R Auto Simplify. This means that you let go of the mouse 
after you have navigated to Auto Simplify. Do this by dragging the mouse to the 
Manipulation Prefs choice under the Manipulate menu. A sub-menu will open 
so you can drag the mouse to Auto Simplify.

MathView provides you several methods of performing manipulations. The guide 
will attempt, in the beginning, to describe most of these to you. As you progress, 
however, the guide will only mention one or two of these methods. In most cases, 
the manipulation method you use is a personal choice. 

The guide does not discuss the use of the Command key equivalent keystrokes in 
the main body of the text because they are not the same on all platforms. You will 
find a list of most of these in the appendix. The menus also display many of these 
next to the commands. You may want to make a list of Command key keystrokes 
to have next to your computer as you learn. Many of them will become the method 
of choice for your manipulations. 

Side Column Icons Icon images in the side column represent Palette methods. They are there to 
remind you that you can click on the same image on the palette to achieve the 
results described in the text. For example, you generate a linear graph by selecting 
the menu choice: Graph R y = f(x) R Linear. The icon in the side column to the 
left of this paragraph indicates that you can click on this palette image to perform 
the same action.

Hand 
Manipulations

MathView allows you to move variables and expressions around the screen by 
invoking the “Hand” cursor. In some cases, the guide will show the expression or 
equation in the middle of one of these manipulations. That part of the expression 
in gray is the selection and that part in reverse video is the target. Reverse video is 
white-on-black in this guide, white-on-color on your screen if you have chosen a 
background color for your system. 

Highlighted areas on 
your screen may be 
colored depending on 
how you have set your 
system.

Palette image of
Linear Graph

SelectionTarget
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Keyboard Actions The guide notates keyboard actions in one of two ways. The first is to write out the 
action, as in, “press the Return key”. The second is to show an image of the key 
itself , which has the same meaning  .

Examples • Bulleted, indented paragraphs indicate the steps of examples. 

Space key Blank spaces may appear to be included in example input. Do not include a space 
(by pressing the Space key) in your inputs unless specifically directed to do so 
with the words “press the Space key” or “press ˙”. Pressing the Space key (or if 
you prefer, Space bar) is a special short-cut in MathView for multiplication. For 
the most part, examples will display the asterisk (*) to denote multiplication. You 
can use the Space key short-cut rather than typing an asterisk for most, if not all, 
multiplications.  

Notes Text in the side column are notes that contain additional information about the 
current subject.

Teacher’s Notes These areas discuss teaching tips.

Return key The Return key on many DOS machines is labeled Enter. If you are using the 
Windows version of MathView, when requested to press the Return key, this 
means that you should press the Enter key on the main keyboard. In all versions, 
the Enter key on the numeric keypad has a totally different function (see page 17).  

RHS/LHS LHS and RHS are abbreviations for the Left Hand Side and the Right Hand Side 
of the equation respectively.

LHS RHS
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A First Example 

This example is for those of you who want to get right to work and would prefer to 
read the guide after a little experimentation. Followed very carefully, this example 
should give you a good start. After you complete the example, you are encouraged 
to continue on in this guide in a sequential manner, or you can go to individual 
subject areas. 

Desktop After installation, you will see the following images on your desktop. For the 
Macintosh, depending on where you have chosen to place the files, your window 
should look similar to the following. 

The Windows desktop will look something like the following.    
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Opening MathView • To open a MathView document on a Macintosh, double-click on either the 
program icon or the notebook called “New Notebook”.  A document will 
open which looks like the following. 

   

The Palette showing is the Variable Palette. If you click on the large x, it will 
change to the Function Palette.    

When you open the Windows version by double-clicking on the program icon, or  
by clicking on the notebook called “Newnote”, the following window will display. 
Below is the Function Palette which you obtain by clicking, again, on the x in the 
Variable Palette.    

Variables
Palette

Click on this and the Palette changes:

Function Palette
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Starting Example 
#1

The screen-shots in the examples are taken from the Macintosh version. They 
apply to the Windows version as well, but may look somewhat different on your 
screen.

Notice that you have a highlighted ? in your Notebook. MathView opens the 
document ready for input.

• The ? is highlighted (if not, select the ? by clicking on it). Type the following. 
 means press the Escape key.    

You have entered a Proposition (abbreviated in the guide as Prop).  

• To show an alternative way to input the equation, select the Proposition by 
clicking once on the rounded square icon to the left and press ƒ. 

This time you will use the Palette to input the same equation.

• Click on the 2 on the Variable Palette.
• Select the multiplication operator inside the a+b  Pop-up menu on the 

Function Palette (a·b ). A ? will appear awaiting an input. 

• Click the Superscript icon on the Function Palette. 

• Click on an x on the Variable Palette.
• Click on the superscript ? to highlight it, and click on 2 on the Variable 

Palette.

• Click on the Select out icon   3 times to highlight the  and select 

the addition operator inside the a+b  Pop-up menu. 
• Click on 1 twice, choose the multiply operation again (a·b ), and then click on 

the variable x. 

• Click once on the Select out icon  and select a+b . Click on y.

• Click on Select out once   to select the whole expression.

• Choose the a=b  operator under the a+b  Pop-up menu and click on x. 

• Click on the Superscript icon again 

• Click on 3, click Select out twice, and choose the addition operator (a+b ). 
• Click on the number 1 and the number 2.

This method looks tedious on paper, but as you learn all of the ways to input 
expressions, you will find this method very useful for much of your input.

• In order to graph this equation you must isolate, or solve for, y. You can do 
this in one of three ways. Each requires you to select y  first. Do this by 
dragging the mouse across y or double-clicking on y until it highlights.

2 * x^2  +11 * x + y = x^3  + 12

The Result is:

Notice that when you 
start inputting, a new 
Prop with a ? 
automatically appears.

You can also generate a 
new Prop by pressing 

.
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The first method is to choose Isolate under the Manipulate menu. The second 
method is to click on the Isolate icon on the Functions Palette (the icon in the 
column to the left of this paragraph).      

The third method is to use the “Hand” cursor to drag the y over to the Prop icon. 
After you select y, move the mouse over it. Hold down the key (Macintosh) or 
the  key (Windows). The cursor will turn into a Hand. Press down on the 
mouse button and, while continuing to press down, drag away (you can let up on 
the key now). A dotted outline will follow the mouse around the screen. Move the 
mouse cursor to the Prop icon and let go. This action isolates y. Below are three 
screen-shots showing the selection, the manipulation, and the result.    

Results have a rounded triangle shaped icon in front of them. A rounded triangle 
indicates that the result is a conclusion to a manipulation. Assumptions are inputs 
(rounded square icons), and Conclusions are answers (rounded triangle icons), 
which result from a MathView manipulation. Notice the word Isolate  to the right 
of the result. After every Conclusion, MathView displays the manipulation that 
caused the result. You can turn this feature off by choosing Show Steps under the 
Notebook R Notebook Prefs menu. To turn it back on, choose it again; it toggles 
on and off each time you choose it. Show Steps is a global command, meaning 
that it affects all of the manipulations in the notebook.

• While the equation is still highlighted, choose Copy under the Edit menu. 
• Select the first Prop by clicking once on the square icon (this action selects 

the Prop and the equation) and choose Paste. MathView generates a new 
Assumption Prop, (preceded with a rounded square icon) below the two 
original Props containing a copy of the conclusion. This step demonstrates 
how you can use the results of a manipulation in a new problem.

• The original Prop is not necessary now, so select it by clicking once on the the 
rounded square icon in front of the equation and press ƒ. Remaining will be 
the newly manipulated equation.  

If you give x a value, what is y?  

• Press , to generate a new Assumption Prop, and type . Select this 
new equation by clicking once on the equal sign and move it, with the Hand, 
to the Prop icon of the y equation and let go. This action will substitute the 

Isolate

Try each method by 
choosing UnDo under 
the Edit menu after 
each manipulation.

Make sure you get the 
pointer all the way over 
and into the Prop icon. If 
you do not make it all 
the way, you will be 
doing a Commute 
manipulation. UnDo 
will let you start over if 
you make this mistake.

Select with Hand.

Drag to Prop icon and let go when 
it highlights.

Prop icon

Result

Copy

Paste

Manipulated equation 
in explicit form

On DOS machines, you 
press the Enter key on 
the main keyboard.

x 3=
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value of 3 into all occurrences of x in the equation.   

• To demonstrate Always ReManipulate, select the 3 in the  Prop and 
change it to a 5. Always ReManipulate works like a spreadsheet with 
auto-calculate turned on, it recalculates the result.  You can turn this feature 
on and off by choosing Always ReManipulate under the Manipulate menu. 
To invoke a ReManipulate when you have Always ReManipulate turned off 
(no check mark), choose ReManipulate Now under the Manipulate menu. 

• You do not need this manipulation now, so select the  Prop (click on the 
icon) and press ƒ. Since the manipulation has no source now, MathView  turns 
the Conclusion into an Assumption (see “Divert Cascade” on page 218 to see 
how to reconstitute this Theory). For now, just press ƒ again. The original 
Prop remains.

One way to find the roots of this equation is to factor the expression on the RHS, 
set y equal to zero, and solve for each x.  

• Select the RHS by double-clicking on one of the operators (either a + or a – 
sign).  

• Choose Factor under the Manipulate menu. When the dialog box appears 
warning that it may take a long time, click on the Yes, go ahead button, or 
press .    

• Create a new Prop and enter y=0. Substitute this equation into the equation 
above, then select each x in the resulting Conclusion separately and Isolate.

Select x = 3 and with Hand 
move to Prop.

Result

x 3=

In the process of changing

Result

When you have 
Always 
ReManipulate 
checked off, you can 
have MathView 
re-manipulate individual 
Props by clicking 
anywhere inside the 
equation of the one you 
want re-maniupulated. 
The selected equation 
and all Props which lead 
to the remanipulation 
re-calculate. All Props 
under, or after, the 
selected equation 
remain un-calculated.

x 5=

RHS means the 
right-hand side of the 
equation.

Factor

Result
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MathView has a root finder that you can use when you plot the function. 

• Select the last Prop and press ƒ until the original equation remains. Click 
anywhere inside the equation (you do not have to select the whole equation), 
and choose Graph R y = f(x) R Linear.    

• To see more of the graph, zoom out once by clicking on the Rocket ship. The 
plot will zoom out by a factor of two each time you click on it.  

To find the roots, you need to zoom in on the x-intercepts (where the line crosses 
the x-axis). 

• Click once on the Knife and move the mouse into the Viewport and select a 
root by clicking to the left and above one of the x-intercepts. While you still 
have the mouse depressed, drag down and to the right, creating a dotted 
rectangle defining a new view. Let go of the mouse and watch the graph 
re-draw, showing only the area defined by the dotted rectangle.   

• Choose Find Graph Root under the Manipulate menu. This action generates 
a self-contained Case Theory defining the value of x at . 

• To find the other roots, select UnDo under the Edit menu. The graph goes back 
to its original view. Perform the manipulation again at a new crossing. The 
UnDo will not affect the Case Theory containing the first root.

You can generate a table to further study this function. You must first create a Case 
Theory so the work you do with the Table will not conflict with the other work in 
the Notebook. 

• Select the last Prop in the Notebook by clicking on its leading icon. Press 
 to generate a new Assumption Prop, and choose Case Theory in the 

Insert sub-menu under Notebook. MathView surrounds the Prop in a box 
with a circle icon, indicating that it is now a Case Theory.

You can notate this area by giving it a descriptive title. 

• Press the Enter-key  (on the numeric key pad). The square icon turns into 

Linear Graph

Rocket ship

Knife

Viewport is the term the 
guide uses to refer to 
the visible area of a 
Graph Theory 
containing the plot.

Select with Knife Result

y 0=

Do not perform any 
other action between 
the generating of the 
root and the Undo. If 
you make a mistake, 
delete the graph by 
clicking on the 
Graph icon at 
the upper left of 
the graph and press ƒ. 
Now start over.

You can change the 
action of the Return and 
Enter keys by selecting
Edit R 
Editing Prefs R 
Enter Key...
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a balloon icon indicating that it is now a text area. The cursor should be 
blinking next to the icon. If not, click the mouse in that area. 
Type,  Generating a Table using the function: 

• Press  to create a new Assumption Prop. 
• Go up to the first Assumption Prop in the Notebook and select the function 

again by clicking once on its equal sign. Select Copy and then Paste it to the 
new Prop inside of the Case Theory. Make sure to select the ? before you 
Paste.   

• Select the equation again and choose Edit R Copy as Picture. Click just to 
the right of the colon in the text area and Paste. MathView copies the 
equation, in real mathematical notation, to the comment area.

You can control the appearance of your comments, including their size, by using 
the Comment Palette area.    

• Click on the balloon icon in the upper left of either the Variables or the 
Functions Palette and hold down the mouse button. The following pop-up 
menu will display.  

By sliding the mouse over to the ruler icon just to the right of the balloon and 
letting go of the mouse, a ruler allowing you to adjust the tabs and size of the 
comment area will open in each Comment area.   

• Since this comment area may be too large to fit on your screen, click on the 
size handle on the right of the ruler and slide it over to the left. The comment 
will wrap to the next line if the ruler is shorter than the existing text.

The other items in the Comment editor allow you to change the type and style of 
the font, along with the color of the font. This Palette Pop-up menu allows you to 
change small areas of a particular comment. To globally change the comment 
areas, and to change the font characteristics of equations, you choose Notebook 
Font... under the Notebook menu. 

• Select the ruler icon in the Comment Palette area again and the rulers will 
disappear. 

• Select the RHS of the equation, and choose Generate... under the 

 then

Size Handle

The largest Prop in the 
Theory determines the 
width of Case Theories. 
In this case, the largest 
Prop is the comment, 
even though the text 
does not fill the 
comment area. By 
reducing the width of the 
comment, the outline of 
the Case Theory will 
shrink. 
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Manipulate R Table menu. When the New Table dialog opens make sure you 
have selected x as the variable and change the value range from 0 ... 6.3 to 
-5 ... 5 with 51 points. Press  or click OK to generate the Table.

To generate a Graph Theory using the data points in the Table, you must give the 
table a name. 

• Click on the ? in the phrase, “Tabulate ? with…” and type a T. Clarify the 
Notebook by choosing Clarify under the Notebook menu and declare T a 
User Defined Function.  Hold down the mouse button on Variable, drag 
down to Function and let go. Finish by pressing  or clicking on the User 
Defined button.    

• Select the Table by clicking once on its icon and generate a plot by choosing 
Graph R Scatter R Linear. Choose x as the x-axis variable and y as the 
y-axis variable leaving the n parameter  as arbitrary. Press .  

Zooming out, by clicking on the rocket, shows the domain limitations when you 
created the table (-5..5). Zoom back in by holding down the  key (Macintosh), 

 and  (Windows), while clicking on the Rocket Ship.

• So that you are looking at the same plot as above, open the graph details by 
clicking on the Details icon and change the Viewport to the following. Select 

Remember, the icons in 
the side column are to 
remind you that you can 
click on the Palette icon 
to perform the same 
operation as indicated in 
the text.

Clarify causes 
MathView to check the 
whole notebook for 
undeclared variables 
and will redraw plots.

Table icon

Scatter Plot

(Mac)

To zoom 
back in

Details
icon

 (Win)
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each number without selecting the attached minus signs and type the numbers 
shown below.    

Below the Viewport are the Scatter Plot details. Experiment changing the style of 
the markers by clicking on the pop-up menus and choosing different styles and 
colors. You can change the Viewport itself by selecting different items in the 
pop-up menus above (Stretch to Fit  and Moderately ). 

• Change to Red Squares and close the details by clicking on the Details icon 
again.

• Plot a line on top of the data by selecting the Table and choosing Add Line 
Plot under the Graph R Additional menu. Choose x & y as the axes and press 

. Open the Graph details again and change the Line detail to match the 
following. Change the domain of the line from Left...Right to -2...4, and the 
line weight from normal  to heavy . Close the details.   

The Graph Theory will reflect any change you make to individual points in the 
table. First move the Table to below the Graph Theory for better viewing during 
this operation. 

• Select the Table by clicking on its leading icon and drag to below the Graph 
Theory with the Hand, using the same method you used to move variables 
earlier in the example. When you are in the right location, a black square 
highlights the area. Let go of the mouse.    

• Open the Table Details by clicking on its Detail icon and change the T(3)  
value from -12 to a value of 0. You will need to scroll your screen down a bit.

Details opened

Details closed

Click on...

to select the table

Line Detail

Select Table

Move to below 
Graph
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The Case Theory will look like the following after you have closed both Details.   

You can extract individual values from the table by setting up a Prop defining a 
function. 

• Select the Table and press  to create a new Assumption Prop. 
• Type  y =, click on the Palette image of T(x) (on the Functions Palette) and 

type an x. 
• Press  and type  x = 5.    

• Select the  equation by clicking on the equal sign, and this time hold 
down the Shift key  while selecting the x in the function. The method of 
selecting more than one item at a time is called Shift-Clicking. 

  

• Choose Manipulate R Other R Substitute. Declare T a User Defined 
Function when the dialog box opens. 

• After the substitution has occurred, select the RHS of the new equation, T(5),  
and Manipulate R Calculate. The Theory will look like the following.         

You can now change the value of x to immediately obtain other y values when you 
have Always ReManipulate turned on. Try this by selecting the 5 in the  
equation and changing it to a 2. 

To demonstrate some calculus manipulations, create a Case Theory below 
everything in the Notebook. 

• Select the last Prop in the notebook (it should be the last Case Theory) and 
press .

x 5=

The Substitute 
Palette icon is inside the 
pop-up hammer icon 
and looks like a lighting 
bolt (with a light grey 
background).

Selection before substitution After substitution and Calculate

x 5=Since you have limited 
the domain (–5..5), if 
you try to input a value 
outside the domain, 
MathView will generate 
a ?.
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To make the Comment area smaller, first change the global width of comment 
areas. 

• Choose Comment Rulers... under the Notebook R Notebook Prefs menu, 
change the width to 4 inches and press . 

• Enclose the Assumption in a Case Theory (with the Prop selected, choose 
Case Theory under the Notebook R Insert menu). Press  to turn the 
Assumption into a Comment, and type Calculus. After pressing , type 
the equation  y = 3*x 2̂  +4*x-11. 

• Generate a Linear Graph Theory and zoom out once.   
• Select the Prop with the equation and press  to create a new Prop. 
• To find the derivative of this function, click on the Derivative Op icon on the 

Palette.   Type a y, † and type an x. The Case Theory will look like the 
following.    

• Select the y equation (click once on the equal sign), and with the Hand, drag it 
to the Derivative Prop. MathView will produce the derivative function.  

You can have the Graph Theory dynamically show the function and its derivative 
by adding a line plot you define as the derivative of y. 

• Eliminate the derivative assumption Prop and its conclusion by selecting and 
pressing ƒ. 

• Select the Graph by clicking on the Graph icon in the upper left corner of the 
graph and choose Graph R Additional R Add Line Plot. This adds a second 
line detail with the same characteristics as the first, except for a new line 
color. Open the details and select the y in this detail.   

• With the y highlighted, click on the Derivative Op again and type an x. 

The Graph Theory is now set up to change both plots when you change the 
original equation. 

Click here once to 
zoom the graph out.

Substitute with Hand Cursor

Recall, that to get the 
hand, you hold down

(Mac) or  
(Win) as you click down 
on a selected 
expression.

You can also select the 
equation and choose 
Add Line Plot.
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• Select the power of x in the original equation (2) and replace it with a. Press 
 and type . The graph will re-draw after a Clarify (under the 

Notebook menu). Change the value of a  and watch the Graph Theory 
re-draw, both the function and the new derivative. The screen-shot below 
shows .  

To complete this example you will find the function whose derivative is 

. In other words, you turn the equation above into a differential 
equation, and solve.

• Create a new Case Theory below the Calculus  Case Theory, by clicking on 
the circle icon, pressing , and choosing Case Theory under the 
Notebook R Insert menu. Press , on the numeric key-pad, and type 
Differential Equation. 

• Input the function in differential form. You do this in the following manner. 
Press , and type     

• Select the whole equation, by clicking on the equal sign, and choose Apply 
under the Manipulate menu. MathView selects both sides of the equation, at 
the same time, for you. Type * d*x to multiply the differential to both sides. 
Once you have performed this step, select the whole equation again by 
clicking on its equal sign and choose Manipulate R Simplify.  

• Your notebook should still have the equation selected; if not, select it now. 
Apply again, then type a $ sign (  - 4), which applies the Integral Op to 
both sides. Select the equation and Simplify with Auto Casing turned on. 
Choose Auto Casing under the Manipulate R Manipulation Prefs menu 

a 2=

a 4=

3x2 4x 11–+

/d*y  d*x  = 3*x^2  + 4 * x -11

Select the equation and Apply

Take d*x times each side

Simplify

Do not use the Palette 
image of the integral in 
this example, as it will 
add a second 
differential.
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prior to the simplify.    

• Isolate y and combine the constants by selecting both and typing a c  without 
a subscript. A new Assumption generates because you have changed the 
Conclusion.     

• Many times you will want to have a hard copy of a MathView session. To 
print this notebook, choose Print Notebook... under the File menu. Choose 
the print settings you want when the dialog opens and press .

This completes the first example. It does not demonstrate all of the manipulations 
available within MathView, but should give you a good start. The next section 
starts at the beginning and works its way through many of the basic features of 
MathView. The later chapters introduce many features through the use of 
examples.

The subscripts for c  
may be different in your 
notebook. Do not worry, 
you will learn how to 
change them later in the 
guide.


